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1. Introduction 

The ISELED application development kit (ADK) gives quick access to the new automotive lighting 

ecosystem provided by the ISELED alliance. It allows to demonstrate the digital LED concept and to 

create dynamic lighting sequences. The kit is based on the ISELED board that shows 16 SmartRGB 

LEDs from Dominant Opto Technologies. Each RGB package includes an INLC100D controller chip 

from Inova Semiconductors with which the devices are calibrated to the same colour gamut and 

brightness. All functions can be controlled via the S32K144 microcontroller unit (MCU) from NXP that 

provides the ISELED serial communication protocol. 

In the default setting, the kit shows an example demo lighting sequence in an endless loop right after 

power up. 

To develop customized sequences and to use the diagnostic features of the controller chip, several 

control commands are provided in a library of an application programming interface (API) which is 

implemented in the ISELED driver from NXP. Furthermore, lighting sequences can also be created with 

the software suite from Lucie Labs which offers an user friendly interface. 

 

 

 

 

 

Kit content 

• ISELED board 

• S32K144-EVB-Q100  

• Power adapter board 

• Board connection cable 

• Micro USB 2.0 cable 

• Power supply 

• Embedded software Lighting stack by Lucie Labs  

• Lucie Creator : a PC tool for easy lighting design, 90 days license included 
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List of Abbreviations and Acronyms 

ADK Application Development Kit 

API Application Programming Interface 

EVB Evaluation Board 

ISELED Integrated Smart Ecosystem Light Emitting Diode 

MCU Microcontroller Unit 
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2. Hardware  

2.1. Hardware Description 

2.1.1. ISELED Board 

The ISELED board contains 16 calibrated SmartRGB LEDs (D65 white point, 1000mcd) from Dominant 

Opto Technologies, two blocking capacitors (100nF, 1µF) at each device, a 7V to 5V low dropout 

regulator and two 8 position nanoMQS headers from Tyco Electronics.   

 

Figure 1 - ISELED board 

 

 

Figure 2 - Connector pin assignment topview master side 
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Figure 3 - Connector pin assignment topview slave side 

 

2.1.2. S32K144-EVB-Q100 

The S32K144 evaluation board (EVB) is Arduino UNO footprint-compatible and it contains the S32K144 

microcontroller [1]. It provides on-chip connectivity to CAN, LIN and UART/SCI buses and flexible power 

supply options (micro USB or external 12V).   

 

Figure 4 - S32K144-EVB-Q100 
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2.1.3. Power Adapter Board 

The power adapter board contains a DC power jack to supply the LEDs and the NXP microcontroller. 

Besides, there are two DC/DC converters (12V to 7V and 7V to 5V) and an INLC100Q16 device [2]. 

This power adapter board provides the INLC100Q16 LED driver chip in a 16 lead WETQFN package 

which converts the single ended communication signal between MCU and the device into a differential 

output signal.  

 

Figure 5 - Power Adapter Board 

 

Figure 6 – Connector pin assignment topview 

 

2.1.4. Board Connection Cable 

The 20cm customized eight wire cable contains two twisted wires for the serial differential 

communication and each three wires for 7V and GND. The wire ends are crimped and connected to 

nanoMQS plugs from Tyco Electronics [3]. 

 

2.1.5. Power Supply 

The provided 12V power supply can drive 1A. If more than four ISELED boards are daisy-chained and 

operated at maximum brightness, the current consumption extends the limit and the power supply must 

be replaced by a stronger device. 
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2.2. Hardware Setup 

To install the hardware, connect all components the following order: 

1. Connect the board connection cable and the power adapter board. 

 

 

 

 

 

 

 

 

2. Connect the other end of the cable to the ISELED board. Ensure that the orange capacitor on the 

backside is first in line. 
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3. Check the position of the J107 jumper and make sure it is in 1-2 position. 

 

 

 

 

 

4. Connect the power adapter board to the S32K144-EVB-Q100 board. 
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5. Connect the power supply plug to the jack of the power adapter board. In the default setting, the kit 

starts to show a demo lighting sequence in an endless loop. By pushing the reset button, the 

sequence can be restarted. 

 

 

 

Optional: 

6. To communicate with the MCU (i.g. to create lighting sequences or use the diagnostic functions), 

connect the USB cable to the S32K144-EB-Q100 board and to the host PC. 
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3. Software 

The ISELED ADK can be controlled via Lucie Creator or the ISELED Driver from NXP.  

If the default firmware, that shows the demo sequence, is overwritten, the link to the Lucie Creator is 

removed. To re-establish the link, the default firmware needs to be re-flashed onto the microcontroller. 

The default firmware can be downloaded at https://iseled.com/products/iseled-application-kit.html. The 

description how to flash the default firmware is given in chapter 3.3. 

 

3.1. Lucie Creator 

Lucie Labs provides the software suite Lucie Creator for the creation of complex lighting effect 

leveraging the ISELED technology. The user-friendly interface enables to preview live the lighting 

content directly on the high density LED topology. 

To create an account on Lucie Creator, follow the steps explained on this set up guide: 

https://support.lucielabs.com/LucieCreatorSetupGuide.pdf 

The tool can be found at https://demokit.lucielabs.com. The free trial version is limited to 90 days and a 

maximal number of 16 LEDs.  

Once you have registered and you are ready to use Lucie Creator, please check this User Guide to 

quickly discover all the software's functionalities: 

https://support.lucielabs.com/LucieCreatorUserGuide.pdf 

 

As long as the default firmware is not overwritten, the online tool can be used when the USB connection 

is established.  

 

Figure 7 - Lucie Creator 

https://iseled.com/products/iseled-application-kit.html
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3.2. ISELED Driver 

To use the ISELED protocol, it is necessary to use the S32 Design Studio IDE (S32DS IDE) – NXP’s 

automotive development environment for the S32K platform of MCUs. How to download the S32DS IDE 

and how to get the required license is described in the “S32K ISELED Driver Installation guide” which 

can be downloaded at https://iseled.com/products/iseled-application-kit.html. 

After successful installation, the pin configurations must be adjusted before generating the Processor 

Expert Code. To do this, "Window" -> "Show View" -> "Components" must be selected. In the component 

"iseled1: iseled", the data pin must be set to PTE16 and the clock pin to PTE15 (s. Figure 8). 

 

Figure 8 – Pin configuration & timeout setting 

If several ADK strips are connected in series or if a self-developed hardware with more than 17 LEDs is 

used, the timeout duration must be increased depending on the number of LEDs n according to the 

following equation: 𝑡𝑖𝑚𝑒𝑜𝑢𝑡 𝑑𝑢𝑟𝑎𝑡𝑖𝑜𝑛 (𝑢𝑠) = 𝑛 𝑥 72 + 40. 

In addition, the number of LEDs and the buffer size in the main function (s. Figure 9) must be adjusted. 

The buffer size must be twice the number of LEDs. 

#define NR_OF_LEDS      17U 

uint32_t digLEDResultBufferStrip1[34]; 
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Figure 9 – main.c 

The control commands can be sent in debugging mode or using the freemaster GUI project 

“Iseled_Driver.pmp”. 

The freemaster GUI can be used after the project has been built and has been flashed onto the 

microcontroller. To build the project, click on the hammer icon (s. Figure 10). 

 

Figure 10 - Hammer icon 
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After this, you can flash the microcontroller by clicking on the flash icon (s. Figure 11). 

 

Figure 11 - Flash icon 

 

Select the tab "Debugger". If the NXP board is correctly connected to the PC via USB (Interface: 

OpenSDA), the corresponding USB port will be displayed (s. Figure 12). If nothing is displayed here, 

check again if the jumper position J107 is correct. 

 

Figure 12 - OpenSDA Interface 
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After successful flashing, the console displays "target disconnected" (s. Figure 13). 

 

Figure 13 - Succesful flashing 

In order to use the project “Iseled_Driver.pmp”, the graphical user interface tool “Freemaster 2.0” must 

be installed. The tool can be downloaded from the following link: 

https://www.nxp.com/support/developer-resources/software-development-tools/freemaster-run-time-

debugging-tool:FREEMASTER?&tab=Design_Tools_Tab 

Now the freemaster project “Iseled_Driver.pmp” can be opened (s. Figure 14). 

 

Figure 14 - Iseled_Driver.pmp 

Please make sure that the settings under “Project” -> “Options” are set as follows: 

 

Figure 15 - Freemaster project options Comm 

Connect string: drv=6;ptype=9;pnum=1;devid=;devlock=0;jtagspd=500 

https://www.nxp.com/support/developer-resources/software-development-tools/freemaster-run-time-debugging-tool:FREEMASTER?&tab=Design_Tools_Tab
https://www.nxp.com/support/developer-resources/software-development-tools/freemaster-run-time-debugging-tool:FREEMASTER?&tab=Design_Tools_Tab
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Makes sure that the default symbol file is set to the .elf file in the subfolder “Debug_FLASH” in the 

workspace folder.  

 

Figure 16 - Freemaster project options MAP Files 

 

The link between freemaster and microcontroller is started by clicking on the stop sign icon. If the 

operation was successful, the question marks in the “Value” column turn into numbers. These values 

can be changed by the user to set the command parameters. 

 

Figure 17 - Freemaster 
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To send the commands, they can be selected in the dropdown list next to the variable “Service Number” 

(s. Figure 18). 

 

Figure 18 - Service Number 

 

The application note “AN_INLC_04” from Inova Semiconductors gives a detailed description of the 

control commands. This document requires a non-disclosure agreement (NDA). 
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3.3. Default Firmware 

To re-establish the link, the default firmware needs to be re-flashed onto the microcontroller. The default 

firmware can be downloaded at https://iseled.com/products/iseled-application-kit.html. 

To flash the firmware, open the S32 Design Studio and click on the flash icon (s. Figure 19). 

 

Figure 19 - Flash icon 

Select “GBD PEMicro Interface Debugger” and click on the „New“ button (s. Figure 20). 

 

Figure 20 - Flash configuration  

https://iseled.com/products/iseled-application-kit.html
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Select the tab "Debugger" und select the S32K144F5 device. If the NXP board is correctly connected to 

the PC via USB (Interface: OpenSDA), the corresponding USB port will be displayed (s. Figure 12). If 

nothing is displayed here, check again if the jumper position J107 is correct. Make sure the GDB client 

settings have the executable ${cross_prefix}gdb${cross_suffix} (s. Figure 21). Save the settings by 

clicking on “Apply”. 

 

Figure 21 - Flash configuration „Debugger“ 
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Select the “Startup” tab and load the ISELED_ADK_default_firmware.hex file as symbol and executable 

(s. Figure 22). Save the settings by clicking on “Apply” and press the “Flash” button. 

 

Figure 22 - Flash configuration “Startup” 

 

 

After successful flashing, the console displays "target disconnected" (s. Figure 23). 

 

Figure 23 - Succesful flashing 
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4. Revision History 

Revision Date Changes 

0.1 February 2018 Initial Release 

0.2 April 2018 
Update chapter 2.2 
Update chapter 3.0 
New chapter 4.0 

0.3 April 2018 Update chapter 3.1 

0.4 April 2018 
Update chapter 3.2 
New chapter 3.3 

0.5 April 2018 Update chapter 3.2 

0.6 June 2018 Update chapter 3.2 

0.7 June 2018 Update chapter 3.2 

0.8 March 2019 Update chapter 3.2 

0.9 April 2019 Update chapter  

Table 1 – Revision history 
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life, or for any other application in which the failure of the product could create a situation where personal injury or death may 

occur.  The Information contained in this document is believed to be current and accurate as of the publication date. Inova 

Semiconductors GmbH reserves the right to make changes at any time in order to improve reliability, function or performance to 

supply the best product possible.  

 

Inova Semiconductors GmbH assumes no obligation to correct any errors contained herein or to advise any user of this text of 

any correction if such be made. 
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